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1 Over View
The new integration relies on a combinatin of embbeded controls and new item types. To 
set these up requires adding new type information to the TFS database forms and type 
defintions. The following is a quick sysnopsis of the steps required to configure and 
install. Each step is covered in more detail later in the manual..

1. Install the integration on a client machine. This is done first so you can have 
access to the registration files mentioned later.

2. It is recommened that you download and install PowerTool 2008 so you will 
be able to use Process Template Editor perfrom steps 5 and 6

3. Register the DoorsLinkType defintion in the TFS database

4. Register the DoorsProxy defitinition in the TFS database

5. For each TFS Project add the DOORS Anchor icon control to the ‘Task’ 
workitem defintion

6. For each TFS Project add the DOORS Link Panel control to the ‘Task’ 
workitem definition

7. For each TFS Project define a “Doors” project area and “Doors/Deleted” 
project area

Methods to configure multiple projects are discussed later in the manual
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Configuration of TFS Server And Projects
2 Configuration of TFS Server And Projects
The following installation procedures can be performed from one of the installed client 
machines using Remote Access and Visual Studio Process Editor Tool as TFS 
Admin with SQL Admin access as well

Before getting started you should locate the installed files on your client machine. 
Normally these files can be located in the below directory:
 Server Configuration Files

C:\Program Files\Telelogic\DOORS_TFS\TFS Server

Register DoorsLinkType definition
1. On the TFS server copy the Server Configuration Files files shown above to 

a local temp area on the server.

2. Edit the importRegistry.bat file and change the parameter “sql-
00a\QLSTFS“ to the name of your TFS SQL server name.

3. Open a SQL server command prompt window as shown below.

4. Run the bat file. Any errors can be found in the file ‘err3.tx’t.

Note  See http://blogs.msdn.com/narend/archive/2006/10/13/how-to-extend-linking-
and-workitem-ui-with-custom-link-types.aspx for information.
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Registering DoorsProxy definition
Registering DoorsProxy definition

Using Process Editor Tool
you can configure the rest of the server XML imports using the MicroSoft Provided 
Power Tool - Process Template Editor.

1. First download and install PowerTool 2008 

2. After installing PowerTool 2008, Start Visual Studio from one of the 
installed client machines.    Open the Process Editor menu and select 
"Import WIT"

3. Login into your server at the prompt

4. Select the project from the list.
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Configuration of TFS Server And Projects
5. Use the Browser to select the DoorsProxy.xml file found in the TFS Server 
folder installed on each client machine.

6. Select the OK button to import the file into the selected project..  To verify 
if this operation completed successfully. select the same Process Editor 
option again and instead of “Import WIT” select “Open WIT From 
Server”  and select the project and expand.. you should see DoorsProxy as 
one of the WorkItem types as shown below…

Configuring Multiple projects
you can use the provided “importProxy.bat” file to import the same xml file as in the 
previous procedure..

1. On the TFS server copy the Server Configuration Files files shown above to 
a local temp area on the server.

2. Edit the importProxy.bat file and change the parameters as follows:

• <c:\temp\doors_proxy.xml> To Doors_Proxy.xml.
• <http://qls.tfsmadeeasy.com:8080> To http://

yourTFSServerName.com:yourPortNumber
• <ProjectName> To your TFS project name ie drsTest

The final form should look something like this:
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Add Embedded Integration Controls
"C:\Program Files\Microsoft Visual Studio 
9.0\Common7\IDE\witimport.exe" /f doors_proxy.xml /t http://
qls.tfsmadeeasy.com:8080 /p drsTest > errImport.txt

3. Run the bat file. any errors will be saved in the errImport.txt file.

4. You can repeat this process changing the Project name each time or repeat 
the command in bat file changing the project name on each line

Add Embedded Integration Controls
To get the new DOORS controls to display on workItem forms you must modify the 
definition for each workitem type in your project.

Add DOORS icon header

  
Icon appears on the workItem form header to allow drag drop linking from TFS to 
DOORS

1. Use the Process Editor to access the WIT (Work Item Type) from Server as 
shown below
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Configuration of TFS Server And Projects
2. Select and expand the TFS Project you wish to configure and a list of all of 
the available Work Item Types (WITs) will be displayed

3. Select the Task WorkItem Type. 

4. Select the “Layout” tab to display the form layout editor….

5. Click on the root node named “Layout” and right mouse click to add a new 
“Group”

6. If necessary move the new group node so that it is the first node under 
“Layout”

7. Select the new Group node and use right mouse button to add another 
column

8. Set the first column percent width to 90 and the second column’s percent 
width to 10
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Add Embedded Integration Controls
9. Select the new column (2nd column) and use right mouse button to add a 
new control

10. Set the control ‘Label’ to blank and use the pull down option to set the 
‘Type’ value to ‘tfsdrs_WitHeaderControl’. 

11. Save the current configuration.

Add Links Tab Control
Appears as one of the standard tabs of each workItem form to allow all link operations.

1. Repeat the above instructions to open the ‘Task’ workitem type using the 
Process Editor tool. Scroll down to the ‘TabGroup’ section and add a new 
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Configuration of TFS Server And Projects
‘TabPage’ . Name the new page “DOORS Links” and move it to where you 
want it to appear relative to the existing tab pages..

2. Under the New DOORS Links tab page a Add a New Control and set the 
Type  to tfsdrs_WitTabControl as shown      

This completes the configuration of the Task Work Item Type . If you wish to have the 
DOORS integration controls display on other work item forms (Requirement, Issue, 
Bug, Change Request..etc) repeat above processes for each type.

Create New Area Paths in Projects
Area Paths are necessary to manage the new Doors Proxy items used to store imported 
DOORS Data. The DoorsProxy type itself can be used to filter out these items from 
users queries.  The Doors area path can be used to further limit user access to this data.. 
Finally when a Doors Link is deleted using the integration - the Deleted Proxy item is 
moved to the Deleted area path.  Due to the nature of Team System and Sarbanes Oxley 
compliance workItems are never physically removed from the database, a work around is 
to move them to an area path with limited access.
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Create New Area Paths in Projects
1. Open the TFS Project as a Project Admin user and create 2 new area paths 
“Doors” and “Doors/Deleted” as shown below

2. Select the ‘Deleted’ node

3. Set the Security for the Deleted node for ‘contributors’ as shown

4. Select the DOORS node
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Configuration of TFS Server And Projects
5. Set the Security for the DOORS node for ‘contributors’ as shown

This completes the configuration for path areas for a Team Project. Repeat these steps 
for each project that will use the integration
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Prerequisites:
3 Client Installation of DOORS TFS 2.0 
Integration on Windows Platform

This chapter/section describes how to install and set up DOORS TFS on a machine that 
does not have previous versions of the integration installed. 

Prerequisites:
1. DOORS 8.3 or  higher client installed 

2. Visual Studio 2008 Installed.

3. Visual Studio Team System 2008 or Visual Studio Professional Edition

4. Team Foundation Server 2008 Client installed.

5. Installation time only: Access to create/write in folder "\Documents and 
Settings\All Users\Application 
Data\Microsoft\MSEnvShared\Addins or access to create sed folder if 
it does not already exist. This folder is located on the same drive as your 
Visual Studio installation. 

6. Installation time only: Access to create/write in folder: "C:\Documents 
and Settings\All Users\Application Data\Microsoft\Team 
Foundation\Work Item Tracking\Custom Controls\9.0” or access to 
create sed folder if it does not already exist. This folder is located on the 
same drive as your Visual Studio installation.

7. Installation time only: Access to create/write in folder “Program Files/
Telelogic/”. This folder is located on the same drive as your Telelogic 
DOORS installation.

Installation of the DOORS TFS Integration
1. Execute the 'DOORS TFS'  installer 

2. Select the Version of DOORS you wish to install for

3. Select the “Telelogic” target directory where DOORS is currently installed. 
ie. “c:/Program Files/Telelogic/”.

4. Proceed with installation wizard.
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Client Installation of DOORS TFS 2.0 Integration on Windows Platform
Post Installation Check List:
If the integration fails to show up on the Studio Tools pulldown menu or it does not 
execute, review the below check list to possibly identify installer errors that could be the 
cause of the problem.

1. Verify the ‘TFS_DOORS_addin.Addin’  file was added to the directory: 
\Documents and Settings\All Users\Application 
Data\Microsoft\MSEnvShared\Addins

2. Verify the folder ‘DOORS_TFS’ was added to the directory: \Program 
Files\Telelogic\

3. Verify the file ‘TFS_DOORS_startup_ncrpt.inc’ was added to the DOORS 
directory: \Program Files\Telelogic\DOORS_9.0\lib\dxl\startupFiles

4. Verify the folder ‘TFS’ was added to the directory: C:\Program 
Files\Telelogic\DOORS_TFS\addins\

5. Verify file exists: Documents and Settings\All Users\Application 
Data\Microsoft\MSEnvShared\Addins\TFS_DOORS_addin2.AddIn

6. Verify file exists: Documents and Settings\All Users\Application 
Data\Microsoft\Team Foundation\Work Item Tracking\Custom 
Controls\9.0\tfsdrs_WitHeaderControl.wicc

7. Verify file exists: Documents and Settings\All Users\Application 
Data\Microsoft\Team Foundation\Work Item Tracking\Custom 
Controls\9.0\tfsdrs_WitTabControl.wicc

8. Verify the below folders are created after the install l

9. Below are the more important files to verify – many other dependency 
library files are included in the install. Verify files exist: \Program 
Files\Telelogic\DOORS_TFS\TFS_DOORS_Addin
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Post Installation Check List:
10. Verify the below files are created after the install. Location Folder: \Program 
Files\Telelogic\DOORS_TFS\addins\TFS

11. Start Visual Studio and verify the following:

a. Go to the Tools menu and select  ‘options...’ 

b. Check the “show All Settings” option in the bottom left of the 
window.

c. Select  ‘Add-in/Macros Security’ option as shown int the 
figure below.

d. Verify you have an entry   
%ALLUSERSPROFILE%\ApplicationData\Microsoft\MSE
nvShared\Addins

e. If not - manually add it to the Add-in File Paths and then 
restart studio

If the integration still fails to show in the forms or from the Tools menu, please contact 
support
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DOORS CONFIGURATION MODULE
4 DOORS CONFIGURATION MODULE
After client installation and TFS server configuration is complete, the integration can 
operate normally without further configuration of the DOORS environment. If the 
integration is executed and links are created the default configuration is used and the 
initiating operation continues normally (see default configuration).
To specify other default settings or define additional Attributes to be imported and 
exported, a TFS DOORS CONFIGURATION module is required. Using the 
configuration module you can specify which link type to use when creating links between 
DOORS and TFS items, define and map what data to import and store in both 
applications, define which DOORS attributes to retrieve for viewing on the “Real Time 
Data” display found on the New DOORS Link Editor Dialog.
The DOORS configuration module settings will apply to all DOORS modules with in 
the same folder and sub folders, similar to the DOORS inheritance method for access 
rights. This allows the ability to group common types of DOORS modules into a folder 
and have unique TFS integration settings for that group. At run time the integration 
searches first in the current Folder/Project for a Configuration module, then searches 
through all ancestor folders/Projects stopping at the first one it finds. If one is not found, 
the initiating operation continues in the integration, but a warning will be provided to the 
user indicating that no DOORS configuration could be found.
The configuration module is composed of 3 Sections:

1. TFS To DOORS

This section is used to map which TFS workitem attributes to import and 
store on the DOORS Object’s External Link attribute.

2. DOORS To TFS

This section is used to map additional DOORS Object attributes to export 
and store in TFS using the DoorsProxy item. Each workitem link to 
DOORS creates a new DoorsProxy item. This item is similar to the 
‘DOORS Surrogate’ object sometimes used in older DOORS integrations.

3. TFS Link Display Info

This section allows the ability to easily define additional DOORS Object 
attributes to be accessed in ‘Real Time’ when a TFS user is viewing a 
workitem to DOORS link using the new DOORS Link Editor dialog. These 
attributes are not stored in TFS and can only be scene from the Link Editor. 
When viewing, the Link Editor attempts to access DOORS and retrieve the 
current attribute data and display it using a dynamic grid list.
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Post Installation Check List:
Create Configuration Module
To Generate a configuration module, open any doors module in the current folder where 
you want the configuration module to apply.  From the module tool bar ‘TFS’ menu 
select the ‘Create Configuration Module’ option. This will generate a new 
configuration  module and open it for edit. 

Note  To Allow multiple Configurations in same DOORS project. The 
current design allows you to place this module in the same project as the 
requirement modules that the mappings apply too. You may also create 
multiple configuration modules. These may be placed in the DOORS local 
container in the nearest “ancestor” container. The tool will then search 
backwards through all ancestry containers until the first Configuration 
module is found.

Adding Attribute and Field mappings

TFS To DOORS
Section 1 of the configuration module -TFS To DOORS contains attribute mappings 
for the data you want to import from a TFS work item and store in DOORS.  This data 
will be stored on the External Link of the DOORS Object as a LINK attribute.  

1. Open the configuration module in EDIT mode.

2. Select the Object “TFS To DOORS” and create a new child object below.
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DOORS CONFIGURATION MODULE
3. Select the new object just created, and click in the “DOORS Attribute” 
column. Enter in the name of the DOORS attribute you want to use to store 
the imported data. This attribute will be created in the DOORS module 
when a link to a TFS workitem is created , Synchronize is executed, or if the 
‘TFS -> Configure Module For Synch..” option is exectuted. 

It is highly recommended that what ever name you choose - it is prefixed 
with “TFS” as a mandated naming standard for DOORS integrations. This 
mandate is to insure unique attribute names that will not conflict with other 
integrations. The attributes “Description” and “Title” are reserved names 
and apply to the External link “Description” and “Name” system attributes

4. Click in the TFS Attribute column. Enter in the name of the TFS workItem 
attribute to be imported. A list of work item attributes available can be 
viewed by using the Visual Studio TFS query results dialog Column setup 
menu option after running any TFS query.

DOORS To TFS
Section 2 of the TFS DOORS CONFIGURATION module can be used to define 
additional DOORS Object Attribute data (in addition to the Default attributes) to be 
exported to TFS and stored in a TFS DoorsProxy workitem. This provides the same data 
per link capability as External Link Attributes in DOORS.
IMPORTANT: In version 2 of the integration, simply adding in new attribute mapping 
data as done in Section 1 WILL NOT cause the integration to import and store attributes 
as a new attribute of the DoorsProxy work item. As stated the in section 1 the TFS 
attribute data must be an existing attribute of the TFS workItem. Since version 2 uses a 
NEW workItem type (DoorsProxy) to store imported data. The DoorsProxy type 
definition must be modified to define attributes/fields to store the NEW attributes you 
wish to import. (see registering DoorsProxy definition for more information).
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Post Installation Check List:
In version 2, a standard Set of Attribute data is always imported into TFS From DOORS.  
These standard attributes are:

• Object URL:
• Module Name
• Object ID
• Object Text
• Object Short Text
• Last Modified On
• Last Modified B

They are stored using a new workitem type called ‘DoorsProxy’ which is created for each 
workitem to DOORS link. The standard attributes are mapped as seen below:
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DOORS CONFIGURATION MODULE
Configure Link Display Info
Section 3 - is used to define the which of the DOORS Object Attributes you want to 
display in the TFS Link Editor: Real Time Report View tab panel

. DOORS Link Editor Dialog accessed from TFS Link Edit option

To display Object Heading and Object Text similar to the DOORS main column enter 
‘Object Heading and Object Text’ as the ‘DOORS Attribute’ value.   To display the 
module name use ‘Module Name’ for the attribute value.
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Post Installation Check List:
Default Configuration
After client installation and TFS server configuration is complete, the integration can 
operate normally without further configuration of the DOORS environment. If the 
integration is executed and links are created the default configuration is used and the 
initiating operation continues normally 

Default Work Item Link Type

The integration defaults to the new ‘DoorsLinkType’ when a new configuration module is created or if no 
configuration module is found

The integration defaults to the new ‘DoorsLinkType’ when a new configuration module 
is created or if no configuration module is found.
If the DoorslinkType is not defined then the integration will attempt to create the link 
useing the known Standard TFS Link Type Names:

• Workitem Hyperlink
• Source Code File
• Test Result

In version 2, a standard Set of Attribute data is always imported into TFS From DOORS.  
These standard attributes are:

• Object URL:
• Module Name
• Object ID
• Object Text
• Object Short Text
• Last Modified On
• Last Modified B
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DOORS CONFIGURATION MODULE
Running without a TFS CONFIGURATION module
Version 2  can operate with no existing configuration on the DOORS side.  When a 
module is linked or synched without configuration the software searches the local folder 
and then all ancestor folders to locate a TFS CONFIGURATION module.  If no 
configuration module is found then the attempted operation continues using the default 
settings 
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Post Installation Check List:
5 Configure DOORS Requirements Module
Before creating links it is best to configure your requirements module using the 
“Configure Module for TFS Synch” option.  Configuration of a module attempts to 
create any user defined attributes identified in Section 1 of the nearest TFS DOORS 
CONFIGURATION module. The software will automatically attempt to create the 
attributes it needs at run time, but it is best to pre-configure each module to minimize the 
possibility of errors due to a user’s access to create new object level attributes.

1. To configure open the module, then select from the tool bar ‘TFS’ menu 
select the ‘Configure Module For TFS Synch’ option

2. A dialog will display listing all the attributes identified in the configuration 
module that apply to the current module.

3. Select ‘Confirm’ to attempt attribute creation.
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Configure DOORS Requirements Module
The configured attributes will be created in the Module as Object level attributes. 
Imported TFS data will actually be stored on the Objects External Link, but in DOORS 
external links inherit the same attributes as the Object they belong to.

Note  It is highly recommended that what ever attribute name you choose - 
it is prefixed with “TFS” as a mandated naming standard for DOORS 
integrations. This mandate is to insure unique attribute names that will not 
conflict with other integrations. The attributes “Description” and “Title” are 
reserved names and apply to the External link “Description” and “Name” 
system attribute
26    DOORS TFS Administrators Guide



DOORS TFS Administrators Guide           27



Connect to TFS Server From Visual Studio
6 Connect to TFS Server From Visual Studio
To execute Team System from the Visual Studio Environment for the first time - do the 
following:

1. Start Visual Studio

2. Select ‘Connect to Team Foundaton Server’ from Visual Studio ‘Tools’ 
menu

3. Click ‘Servers’ option

4. Select “Add...” new server option

5. Enter in Server Name, Port Number and Protocol of your TFS server
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6. Select ‘Team Explorer’ tab found in the far right corner of Studio

7. Select the ‘Add Existing Team Project’ option at the top of the Team 
Explorer

8. Provide a valid TFS user login name and password: 

9. Select the Project you wish to open
DOORS TFS Administrators Guide           29



Connect to TFS Server From Visual Studio
10. Expand the Project Tree (TFSDOORS in our example case)  and wait until 
‘Work Items’ are loaded

11. Expand Work Items folder, then expand ‘Team Queries folder

12. Activate the “All Work Items” query.
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7 Message Ouput Display and Logging
Report Dialog:

Version 2 displays multi item operation messages using a dialog that pops up when you 
do a synchronize operation or if there were errors on a link drag and drop or delete 
operation.
The above example shows some of the messages and format when things go wrong.. 
such as doors links using link types other than the DOORS Link Type in this case.

Log File:
The integration also generates a log file each time it is executed.  The log file will be 
placed in the directory path specified by the environmental settings in the ‘TEMP’ 
environment variable standard on most windows platforms.  Normally the path is similar 
to the example below:
C:\Documents and Settings\JohnDoe\Local Settings\Temp\tfsdrslog.txt
The log file contents can also be viewed in real time from the Visual Studio Output Pane

Visual Studio Output Window:

Error and log messages are also displayed on the Visual Studio Output window. To 
display goto toolbar menu ‘Edit->Other Windows->Output’
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DOORS Proxy Item
8 DOORS Proxy Item

In order to support the extended “Link Attributes” for links of ‘DoorsLinkType’, a 
proxy/surrogate workitem object is used as recommended by Microsoft.  For this version 
of the integration a new WorkItem type is defined (DoorsProxy)  and will live in the same 
WorkItem DB Table..  This design requires less configuration and more Reporting 
capability. Normally new external link types, require a NEW SQL DB to be created to 
house the external proxy items.
To help isolate these proxy items from the normal WorkItems, the proxy objects live in 
different area paths.  The first area path is called “Doors” and is a sub area under the 
main Project area.  The second area path is called “Doors\Deleted” and is a sub area 
under ‘Doors’.  When a Link to DOORS is created a new Proxy object is created and 
placed into the “Doors” area.  At this time the only way to filter these objects out of the 
“All workItems” Query is to modify the query to not accept items of type “DoorsProxy” 
or not accept “Blocked” items or filter for “areaPath” != @Project “/Doors”
The second area “Doors\Deleted” is used when a DOORS link is deleted USING ONE 
OF THE DOORS INTEGRATION DELETE OPTIONS… Normal link delete will 
delete the workitem link but it does not modify the DoorsProxy item and it will remain 
ACTIVE until an Admin clean up is performed… If the link is deleted using the 
integration,  the DoorsProxy object will changed to a new STATE of ‘Deleted’ and will 
be moved into the ‘Doors\Deleted’ areaPath..  This area path if configured as instructed 
later, should have security settings so that ‘contributors’ do not have certain access rights.  
These restricted rights will automatically filter the DELETED items from any future 
queries..  
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The reason for not just ‘deleting’ the proxy object from the database is because the TFS 
process does not allow any workitem deletions physically from the database..  The reason 
is documented as to support Sarbanes Oxley compliance -which restricts deletion of data 
for any reason through the interface or api…  However; since TFS is hosted on SQL 
server, a Server Admin could clean up records in the WorkItem Table and bypass the TFS 
Server layer..  This is only recommended for removal of DoorsProxy objects that are in a 
State of Deleted or have no link to an existing WorkItem

Link Attribute Change History

One of the added benefits of the DoorsProxy item is that an automatic change History is 
kept by the system
DOORS TFS Administrators Guide           33



Contact Support
9 Contact Support
Support and information for Telelogic products is currently being transitioned from the 
Telelogic Support site to the IBM Rational Software Support site. During this transition 
phase, your product support location depends on your customer history.
If you are a heritage customer, meaning you were a Telelogic customer prior to 
November 1, 2008, please visit the Telelogic DOORS Support site.
Telelogic customers will be redirected automatically to the IBM Rational Software 
Support site after the product information has been migrated.
If you are a new Rational customer, meaning you did not have Telelogic-licensed 
products prior to November 1, 2008, please visit the IBM Rational Software Support site.
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